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Introduction 
For the majority of horticulture industry, there are requirements for grower s to record their 

agrichemical use. SprayLog software is designed to help growers meet these industry 

requirements by making it easy to record what, when and where agrichemicals are applied on 

their properties. Not only is the software designed to make it easy, but SprayLog can also use the 

information enter ed for making creating summaries and analysis reporting. 

SprayLog is continually growing, meeting the needs of the horticulture industry  as it develops. 

Every spring a new version of SprayLog is released independent of the previous one with new 

features. This allows HortPlus to developed new features that would be incompatible with old 

versions of SprayLog but still enables the grower to always have access to previous season data. 

Recording agrichemical use is not the only thing SprayLog can be used for. Growers can record 

their crop phenology information by storing the date at which key growth stages occur. In 2008, 

basic pest and disease monitoring was also added. 

System Requirements 

The following operating systems are currently supported by the SprayLog software. Current 

Critical Updates, Windows Updates, and Service Packs must be installed (see 

http://windowsupdate.microsoft.com ). 

¶ Windows 7 

¶ Windows Vista 

¶ Windows XP 

Minimum hardware requirements are 

¶ x86 or x86_64 processor, 500 MHz (or faster) with 512 MB RAM (Windows XP) or 1 GB 

RAM (Vista/Windows 7). 

¶ 10 MB hard disk space 

.ÏÔÅȡ !ÐÐÌÅ -ÁÃȭÓ ÁÒÅ ÎÏÔ ÓÕÐÐÏÒÔÅÄȢ #ÉÔÒÉØ ÉÓ ÎÏÔ ÓÕÐÐÏÒÔÅÄȢ 

Initial Setup 

Be sure that your computer meets the system requirements. Download and run the SprayLog 

install file from the website. 

Note: Depending on which browser you use, the following instructions may not match what you see 

on your computer. If so, save the file to your computer and double click it to launch the SprayLog 

installation process and follow the installation guide below. 

 

http://windowsupdate.microsoft.com/
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1. Open your internet browser, type in to the address bar 

http://www.spraylog.co.nz  and hit Enter. 

 

Note: Your internet browser is the program you use to 

browse the internet ɀ the most common one being 

-ÉÃÒÏÓÏÆÔȭÓ )ÎÔÅÒÎÅÔ %ØÐÌÏÒÅÒȢ 

 

 

2. Click on the Download  tab first and then click on the 

red Download SprayLog  button  to begin the process of 

downloading the SprayLog install file. 

 

 

 

 

 

3. A File Download  window will appear, click the Run  

button.  

 

Note: Depending you your internet connection speed, it 

may take a few minutes for the file to download and the 

next window to popup. 

 

 

4. Once the download is complete you may get a security 

warning, confirming  you want to run the file. Click the  

Run button to launch the SprayLog installation process 

and follow the installation guide below. 

 

 

Installation guide 

Once the installation wizard has begun, you will be taken through a series of steps to setup 

SprayLog on your computer. If you have a previous version of SprayLog already installed in its 

default location, the installation process will detect it and copy across your information during 

the install process saving you from having to enter it again. 

Note: It is strongly recommended that you do not change the default values during the installation 

process. 

 

http://www.spraylog.co.nz/
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1. Welcome  ɀ Make sure you are installing the correct 

version of the SprayLog software. Click the Install  

button to begin. 

 

 

2. Target Directory  - Specify where you would like to 

install SprayLog on your computer. Click the OK  

button to continue.  

 

 

3. Agreement  - Read the screen titled Agreement. If you agree with the written statement 

and wish to continue to install  SprayLog onto your computer, click the Agree button. 

Otherwise click the Don't Agree button. This will stop SprayLog from being installed on 

your computer. 

4. Installation  ɀ The program is installed on your computer. 

Wait while the program installs.  

 

 

 

5. Program Group  - Specify the program group to place 

the shortcut icons in the start menu. Click the OK  

button to continue.  

 

 

6. Existing Location  ɀ If you installed the previous 

version of the software to a different location than the 

default, you will need to show the installer where it is 

so that your data from that version can be copied. If 

not, click the Skip  button to continue.  

 

7. Clean Up  - Final installation processes are run. Wait while the installation finishes.  

 

8. Installation Complete  - The software has installed 

successfully. Click OK  to complete and close the 

installer. 
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Basic Operation 
If you are new to SprayLog it is recommended that you read this section before using the 

SprayLog software. It covers the basics of getting started in great depth ɀ most features are 

skipped in order to keep things simple but are detailed elsewhere in the manual. 

The SprayLog Workspace 

The main screen of SprayLog is separated in to two major areas, the Block area and the Diary area 

highlighted below by the dashed lines. 

The block area contains a grid of blocks and a panel of additional information about the selected 

block. The selected block is highlighted below by the red dotted line. As different blocks are 

selected in the grid , the panel is updated so the current selected ÂÌÏÃËȭÓ ÖÁÌÕÅÓ ÁÒÅ ÓÈÏ×ÎȢ 

Similarly the diary area contains a grid of spray applications and a panel of additional information 

about the selected spray application. The selected spray application is highlighted below by the 

green dotted line. As different spray applications are selected in the grid, the panel is updated too 

so ÔÈÅ ÃÕÒÒÅÎÔ ÓÅÌÅÃÔÅÄ ÓÐÒÁÙ ÁÐÐÌÉÃÁÔÉÏÎȭÓ ÖÁÌÕÅÓ ÁÒÅ ÓÈÏ×ÎȢ 

The diary area and the block area are linked so that the diary area will only show the information 

for the selected block. This is updated every time a different block is selected, highlighted below 

by the large arrow. 
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Owner Details 

The Owner Details window will continue to popup every time 

you open SprayLog until you complete the required fields with 

your details. If you need to change your details, you can access 

this window at anytime from the top menu.  

 Edit > Owner Details  

Note: If you have the previous version of SprayLog installed in the default directory you will find the 

owner details have been copied into this version for you. 

Grower Product List 

SprayLog has a complete list of all the New Zealand registered products for use in the horticulture  

industry , also hundreds of supplementary products. This list is managed by HortPlus and Plant & 

Food Research. 

Note: For more information on updating this list see the Updating SprayLog Database Files chapter. 

To save you having to find the product you are after in a list of over 2000, SprayLog allows you to 

create your own subset list that contain s just the products relevant to you; this is called the 

Grower Product List . There are two ways to access this window; click the Edit My Product List  

button on the main screen or use the top menu. 

 Edit > Product Lists 

Note: If you have the previous version of SprayLog installed in the default directory you will find the 

grower product list has been copied into this version for you. 

The Edit Grower Product List  window has two 

grids, the top grid is the list of all the products, 

and the bottom grid is the ÇÒÏ×ÅÒȭÓ subset list of 

products relevant to them. 

To add a product to the bottom grid,  select a 

product from the top grid and click the Add  

button , you will see it added it to the bottom 

grid.  

Once you have added the product into the 

bottom grid, you can optionally set a default rate 

and rate units; this can come in handy when 

adding spray records. 

Note: See the Stock System chapter about the Amount in Stock field. 
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To remove a product from the bottom grid, select the product and click the Delete  button. This 

will only remove th e product from the bottom grid - your subset of products, not the top grid ɀ 

the entire list of products. 

This information can be changed at any time. 

The other buttons above the Add  button can be used to help you find products in the top grid. 

¶ Filter  wil l allow you to search for text and temporarily 

remove all the items in the top gird that do not match.  

  

Highlight  the Field  you want to filter on, select the 

appropriate Search Type options, fill  in the Field 

Value  text box with the text you want to match  and 

click the OK  button. Remember to press the Clear Filter  button once you are done to re-

add the temporarily removed products. 

 

¶ Locate  will try to match a product as you type. 

 

At the bottom of the window select a field to Search 

By. Fill in the Search Characters  text box at the top 

of the window with the text you want to match, as you 

type the closest matching product will be selected. 

You can select any product from the list and click the 

OK  button.  

 

 

¶ Search is similar to Filter  but will not remove t he items in the top 

grid that do not match, instead it will jump to the first matching 

product in the list.  

 

Fill in the Field Value  text box with the text you want to match, select 

the appropriate Search Type options, select the field you want to 

search on and click the First  button. Press the Next  button to ju mp to 

the next matching product in the list.  

Block Setup 

You will need to break your property down into blocks, if you have not already done so. SprayLog 

considers a block to be an area of land that has one type of crop and variety on it. Each block has 

its own spray diary. 

Note: If you have the previous version of SprayLog installed in the default directory you will find the 

block details have been copied into this version for you. 
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To add a block, on the main screen click the Add Block  button, this will create a blank record in 

the block grid. All the fields are optional but we recommend you fill in the following as a 

minimum.  

¶ Block Name  This is for your reference, whatever you know the block by. 

¶ Crop  Click on the small  in the crop field to select a crop. 

¶ Variety  Clone  Click on the small  in the variety clone field and select a variety. 

¶ Area  Fill in how many hectares the block is.  

Note: 1 acre = 0.405 hectares 

To delete a block, on the main screen select the block you want to delete and click the Delete 

Block  button.  

.ÏÔÅȡ 9ÏÕ ÍÕÓÔ ÄÅÌÅÔÅ ÁÌÌ ÓÐÒÁÙ ÁÐÐÌÉÃÁÔÉÏÎÓ ÆÒÏÍ ÔÈÅ ÂÌÏÃËȭÓ ÓÐÒÁÙ ÄÉÁÒÙ ÂÅÆÏÒÅ ÉÔ ÃÁÎ ÂÅ ÄÅÌÅÔÅÄȢ 

Recording Spray Applications 

The same product cannot be recorded to the same block on the same day, if you are in this 

situation you will need to add the application rates together and enter it as one application. Each 

block has its own spray diary but you are able to enter applications on multiple blocks at once. 

To add a new spray application, on the main screen click the Add Spray button, this will start the 

Add Spray Wizard  which will guide you through the steps involved in adding a spray in to 

SprayLog. At the end of each step, click the Next  button to continue.  At anytime, click t he Cancel 

button to abort the wizard. 

1. Use the small  to show the calendar, select a Date  

then enter a Water Rate . 

 

 

 

 

 

 

2. Highlight the blocks to be sprayed. Double click a 

block to highlight or un -highlight.  
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3. Highlight which products to be applied, check the 

Rate and Rate Units , these can be changed if 

required. 

This is your Grower Product List, you can click the 

Edit List  button to open the Edit Grower Product 

List  window, where you can add or delete products 

from the list . See the Grower Product List chapter 

above for more information. 

 

4. Fill in additional information about the application by 

selecting the appropriate response from the drop 

down boxes or typing in the information directly. Click 

the Finish  button.  

 

 

 

 

Once a spray has been entered, it can be edited on the main window. To edit a spray application, 

on the main screen select the appropriate block then on the spray you wish to edit. Change the 

required parameters by clicking on the appropriate cell, additional application details for the 

current selected spray can be edited using the panel on the right -hand side of the diary grid.  

To delete a spray, on the main screen select the appropriate block then select the spray you want 

to delete and click the Delete Spray  button.  

Save & Close SprayLog 

All entries made into SprayLog are automatically saved as they are entered, but it is good practice 

to manually save before closing the program. 

File > Save 
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Additional Recording 
SprayLog not only helps you to record spray applications, but also pest and disease monitoring 

and crop phenology with block growth stages records. 

 

Recording Pest & Diseases 

The same pest or disease cannot be recorded to the same block on the same day, if you are in this 

situation you will need to add the monitoring result s together and enter it as one record. Each 

block has its own monitoring records. 

Note: For more information on updating the pest and disease lists see the Updating SprayLog 

Database Files chapter. 

 

 

To add a new monitoring record, on the main screen click on the Pest and Disease  tab and click 

the Add Pest button, this will start the Add Pest and Disease  Wizard  which will guide you 

through the steps involved in adding a monitoring record in to SprayLog. At the end of each step, 

click the Next  button to con tinue. At anytime, click the Cancel button to abort the wizard.  

 

1. Use the small  to show the calendar, select a Date  

then select a Measurement Type . 
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2. Select the block the monitoring was carried out on. 

Only one block can be selected. 

 

 

 

 

 

 

 

 

 

3. Select which pest or disease was found. Use the Speed 

Search text box to type in the pest or disease, the 

closest matching item in the list will be selected. 

 

 

 

 

 

 

4. Fill in additional information about the monitoring 

record by selecting the appropriate response from the 

drop down boxes or typing in the information directly. 

Click the Finish  button.  

 

 

 

 

 

Once a monitoring record  has been entered, it can be edited on the main window. To edit a 

monitoring record , on the main screen select the appropriate block then on the monitoring 

record you wish to edit. Change the required parameters by clicking on the appropriate cell, 

additional details for the current selected record can be edited by clicking on the More Info  

button.   

To delete a monitoring record , on the main screen select the appropriate block then select the 

monitoring record  you want to delete and click the Delete Pest button.  
























